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1 Introduction

1.1 Add-onModule RF-/STEEL NBR

The Standard ABNT NBR 8800 Design of steel and composite structures for buildings [1] describes
the design of steel buildings in the Federative Republic of Brazil. With the add-on modules
RF-STEEL NBR (for RFEM) and STEEL NBR (for RSTAB), DLUBAL provides powerful tools for the design
of steel beammodels according to this Standard.

In the following, the add-on modules of both main programs are described in one manual and
are referred to as RF-/STEEL NBR.

RF-/STEEL NBR performs all typical ultimate limit state designs as well as stability and deforma-
tion analyses. The program takes into account various actions for the ultimate limit state design.
The allocation of designed cross-sections into three types (compact, noncompact and slender)
makes an important part of the design according to the Brazilian Standard. The purpose of this
classification is to determine the range in which the local buckling in cross-section parts limits the
load capacity so that the rotational capacity of cross-sections can be verified. RF-/STEEL NBR deter-
mines the limiting width-to-thickness ratios of compressed parts and carries out the classification
automatically.

For the stability analyis, you can determine for every single member or set of members whether
buckling and flexural buckling is possible. Lateral restraints can be added for a realistic represen-
tation of the structural model.

Formodelswith slender cross-sections, the serviceability limit state has become an essential aspect
of the design. The limit deformations are preset according to the Standard, but can be adjusted.
In addition, you can specify the reference lengths and precambers, if necessary.

The program allows you to optimize cross-sections and to export them to RFEM or RSTAB. Using
the design cases, it is possible to design separate structural components of complex structures or
analyze alternatives with different sections or materials.

Since RF-/STEEL NBR is integrated in the main program, the design relevant input data is preset
when themodule is called up. After the analysis, the design results can be evaluated graphically in
the work window of RFEM or RSTAB. Last but not least, it is possible to keep records of the analysis
in the global printout report which includes the internal forces and the design results.

We hope you will enjoy working with RF-/STEEL NBR.

Your DLUBAL team

1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described in
detail in the manuals of the main programs RFEM and RSTAB. The present manual focuses on
typical features of the RF-/STEEL NBR add-on module.

The descriptions in this manual follow the sequence and structure of the module's input and
results windows. In the text, the described buttons are given in square brackets, for example
[View mode]. At the same time, they are pictured on the left. Expressions appearing in dialog
boxes, windows, and menus are set in italics to clarify the explanations.

At the end of the manual, you can find the index. If you cannot find what you are looking for, go
to the Knowledge Base where you can search for the solution of the problem. Or consult the FAQs
on our website.

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base
https://www.dlubal.com/en/support-and-learning/support/faq
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1.3 Starting RF-/STEEL NBR
RFEM and RSTAB provide the following options to open the RF-/STEEL NBR add-on module.

Menu
To start the program from the menu bar, select

Add-onModules → Design - Steel → RF-/STEEL NBR.

Figure 1.1: Menu Add-onModules→Design - Steel→ RF-STEEL NBR

Navigator
You can also start the add-on module in the Data navigator by selecting

Add-onModules → RF-/STEEL NBR.

Figure 1.2: Data navigator Add-onModules→ RF-STEEL NBR
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2 Input Data
When you have started the add-on module, a new window appears. In this window, a Navigator
is displayed on the left. It manages the different window that can be currently selected. The
drop-down list above the navigator contains the design cases (see Chapter 7.1, page 39).

The design-relevant data is to be defined in several input windows. When you open RF-/STEEL NBR
for the first time, the following parameters are imported automatically:

• Members and sets of members

• Load cases, load and result combinations

• Materials

• Cross-sections

• Effective lengths

• Internal forces (in background, if calculated)

To select a window, click the corresponding entry in the navigator. To set the previous or next
input window, use the buttons shown on the left. You can also use the function keys to select the
next [F2] or previous [F3] window.

[OK] saves the results. Thus, you quit RF-/STEEL NBR and return to RFEM or RSTAB. To exit the
add-on module without saving any changes, click [Cancel].

2.1 General Data

In the 1.1 General DataWindow, you can select the members, sets of members and actions for the
design. The two tabs manage the load cases, load and result combinations for the different types
of design.

Figure 2.1: Window 1.1 General Data
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Design of

Figure 2.2: Design of members and sets of members

The design can be carried out forMembers as well as for Sets of Members. If you want to design
only selected objects, clear the All check box. Then you can access the text boxes to enter the
numbers of the relevant members or sets of members. The [Delete] button clears the list of preset
numbers. The [Select] button enables you to define the objects graphically in the work window of
RFEM or RSTAB.

When you design a set of members, the program determines the extreme values of the analyses
of all members contained in the set of members and takes into account the boundary conditions
of connected members for the stability analysis. The results are shown in Windows 2.3 Designs by
Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List by Set of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM or
RSTAB appears. There you can specify the parameters of the set of members.

Comment
In this text box, you can enter user-defined notes, for example to describe the current design case.

2.1.1 Ultimate Limit State

Figure 2.3: Window 1.1 General Data, tab Ultimate Limit State

Existing Load Cases and Combinations
This column lists all load cases, load combinations, and result combinations that have been created
in RFEM or RSTAB.

To transfer selected items to the Selected for Design list on the right, click . Alternatively, you
can double-click the items. To transfer the complete list to the right, click .

To select several items at once, click them while pressing the [Ctrl] key – as common for Windows
applications.
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If a load case is highlighted in red, it cannot be designed. This happens when a load case has no
loads or contains only imperfections.

At the end of the list, some filter options are available. They help you to assign the items by
load case, load combination, or action category. The buttons next to the box have the following
functions:

Selects all load cases in the list

Inverts the selection of load cases

Table 2.1: Buttons in the Ultimate Limit State tab

Selected for Design
The column on the right lists the load cases, load and result combinations selected for design. To
remove an item from the list, click or double-click the item. To transfer the entire list to the
left, click .

Result combination

The design of an enveloping max/min result combination RC is faster than the design of all con-
tained load cases and load combinations. However, the influence of the contained actions is
difficult to check afterwards.

2.1.2 Serviceability Limit State

Figure 2.4: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This section lists all load cases, load and result combinations that have been created in RFEM or
RSTAB.

Selected for Design
You can add or remove load cases, load and result combinations as described in Chapter 2.1.1.

The limit values of the deflections are preset in the Details dialog box (see Figure 3.1, page 19). To
adjust those values, click the [Details] button.

In the 1.8 Serviceability DataWindow, you can specify the reference lengths of the deformation
analysis (see Chapter 2.8, page 18).
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2.2 Materials
This window consists of two parts: The upper table lists all materials created in RFEM or RSTAB.
The Material Properties section below shows the characteristics of the current material, i.e. the
table row which is selected above.

Figure 2.5: Window 1.2 Materials

Materials that will not be used in the design appear gray in color. Materials that are not allowed
are highlighted in red. Modified materials are displayed in blue.

The material properties required to determine the internal forces (Main Properties) are described
in Chapter 4.3 of the RFEMmanual and Chapter 4.2 of the RFEMmanual. The material properties
required for design (Additional Properties) are stored in the global material library. These values
are preset.

To adjust the units and decimal places of the material properties and stresses, select Settings→
Units and Decimal Places from the menu bar of the module (see Chapter 7.3, page 43).

Material Description
The materials defined in RFEM or RSTAB are preset, but you can always modify them: Click the
material in column A, and then click the button or press the function key [F7] to open the
material list.

Figure 2.6: List of materials
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According to the design concept of the Standard [1], only materials of the Brazilian Steel category
are available in the list.

When you have imported a material, the design-relevantMaterial Properties are updated.

As a matter of principle, the material properties cannot be edited in the RF-/STEEL NBR module.

Material Library
Alternatively, you can use the material library to change a material. To open the library, select

Edit → Material Library

or use the [Liberary] button.

Figure 2.7: Dialog boxMaterial Library

In the Filter section, ABNT NBR 8800:2008 is the default Standard. Select the material quality that
you want to use for the design in the Material to Select list. You can check the corresponding
properties in the dialog section below.

Click [OK] or press [ ] to transfer the selected material to Window 1.2 of RF-/STEEL NBR.

Chapter 4.3 of the RFEM manual and Chapter 4.2 of the RSTAB manual describe in detail how
materials can be filtered, added, or rearranged.

In the library, you can also select materials of categories Cast Iron and Stainless Steel. Please check,
however, whether those materials are covered by the design concept of the Standard [1].
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2.3 Cross-Sections

This windowmanages the cross-sections used for design. In addition, the module window allows
you to specify optimization parameters.

Figure 2.8: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM or RSTAB are preset with their material numbers.

If you want to modify a cross-section, select the entry in column B. Click the button or in
the box, or press the function key [F7] to open the cross-section table of the current cross-section
type (see Figure 2.9).

In this dialog box, you can select a different cross-section. To select a different section category,
click [Back to cross-section library] to access the global library of cross-sections.

Chapter 4.13 of the RFEM manual and Chapter 4.3 of the RSTAB manual describe how sections
can be selected from the library.

You can directly enter the new cross-section description in the text box. If the entry is listed in the
database, RF-/STEEL NBR imports the cross-section parameters.

A modified cross-section will be highlighted in blue.

If the cross-section in RF-/STEEL NBR is different from the one of RFEM or RSTAB, both sections
are displayed in the graphic area. The designs will then be performed with the internal forces of
RFEM/RSTAB for the section defined in RF-/STEEL NBR.
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Figure 2.9: IS cross-section types in the cross-section library

Cross-Section Type
The program displays the type of cross-section that will be used for the classification according to
[1] Clause 5.1.2.1.

Max. Design Ratio
This column is shown only after the calculation. It is useful for the optimization: By means of the
design ratios and colored relation scales, you can see which cross-sections are little utilized and
thereby oversized, and overloaded and for this reason undersized.

Optimize
It is possible to optimize every cross-section from the library. The program searches the cross-sec-
tion that comes as close as possible to a user-defined maximum utilization ratio. You can specify
this maximum ratio in the Details dialog box (see Figure 3.1, page 19).

To optimize a cross-section, open the drop-down list in column D (resp. E) and select From current
row. Recommendations on the optimization can be found in Chapter 7.2 on page 41.

Remark
This column shows remarks as footers. They are explained below the cross-section list.

Member with Tapered Cross-Section
For tapered members with different cross-sections at the member start and member ends, the
module displays both section numbers in two rows, according to the definition in RFEM or RSTAB.

RF-/STEEL NBR also designs tapered members, provided that the section at the member start has
the same number of stress points as the cross-section at themember end. If the two cross-sections
have different numbers of stress points, the intermediate values cannot be interpolated. In this
case, the calculation is neither possible in RFEM/RSTAB nor in RF-/STEEL NBR.
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The stress points including their numbering can be checked graphically: Select the cross-section
in Window 1.3 and click the [Info] button. The dialog box shown in Figure 2.10 appears.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can check on the cross-section properties, stress
points, and c/t-parts.

Figure 2.10: Dialog box Info About Cross-Section

The buttons below the cross-section graphic have the following functions:

Click the buttons find detailed information on the Stress points (centroidal distances, statical
moments of area, warping constants etc.) or c/t-Parts, respectively.

Figure 2.11: Dialog box Stress Points of VS 300x46
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2.4 Intermediate Lateral Restraints

InWindow 1.4, you can define lateral restraints formembers. In RF-/STEEL NBR, this kind of support
acts perpendicular to the z-axis of the cross-section (the minor axis, see Figure 2.10). Thus, you
can manipulate the effective lengths of the members for the stability design concerning flexural
buckling and lateral-torsional buckling.

Figure 2.12: Window 1.4 Intermediate Lateral Restraints

In the upper table, you can assign up to nine lateral restraints to eachmember. The Settings section
below shows a column overview for the member selected above.

To define the restraints of a specific member, select the Lateral Restraints check box in column A.
Then the other columns will be accessible where you can enter the parameters. To graphically
select the member, click .

In column C, you can specify the Number of the intermediate restraints. Depending on the specifi-
cation, one or more of the following Intermediate Lateral Restraints columns will be available for
the definition of the x-locations.

When the Relatively (0 ... 1) check box is activated, you can define the support points by their
relative spacings. The positions of the intermediate restraints result from the member length and
the relative distances from the member start. When you clear the Relatively (0 ... 1) check box, you
can define the absolute distances.
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2.5 Design Parameters

This window controls specific parameters that are relevant for the design according to [1].

Figure 2.13: Window 1.5 Design Parameters

For each member, the Gross Area of the section is listed. The values can be modified in the Net
Area column, e.g. when there are holes in the section. The net area An is required for the design of
members for tension according [1] Clause 5.2.

The ReductionFactorCt is related to the plastic behavior of the section. It can be specified according
to [1] Clause 5.2.5.

In the last column, the Effective Area Ae of the cross-section is shown for each member. The values
are determined from the data of the two previous columns.
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2.6 Effective Lengths - Members

Thewindow consists of two parts. The upper table presents a summary of all length factors of buck-
ling, torsional buckling and lateral-torsional buckling as well as the respective member lengths.
The effective lengths defined in RFEM or RSTAB are preset. In the Settings section, additional
information about the member selected in the upper table is given.

You can make any changes in the upper table as well as in the Settings tree.

Click to select a member graphically and show its row.

Figure 2.14: Window 1.6 Effective lengths - Members

The effective lengths for buckling about the minor z-axis and torsional as well as lateral-torsional
buckling are aligned automatically with the settings of Window 1.4 Intermediate Lateral Restraints
(see Chapter 2.4). If intermediate lateral restraints divide the member into segments of different
lengths, no values are displayed in the table columns G, J, and L.

You can enter the effective lengths manually in the table and in the Settings tree, or define them
graphically in the work window by clicking the button. The button is active when you place the
cursor in the text box (see Figure 2.14).

The Settings tree includes the following parameters:

• Cross-Section

• Length of the member

• Buckling possible for the member (cf. column A)

• Buckling about Major Axis y Possible (cf. columns B to D)

• Buckling about Minor Axis z Possible (cf. columns E to G)

• Torsional Buckling Possible (cf. columns H to J)

• Lateral-Torsional Buckling Possible (cf. columns K and L)

• Modification Factor (cf. column M)
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The table controls for whichmembers an analyis of buckling, torsional or lateral-torsional buckling
is to be performed. In addition, the Effective Length Factor and the Modification Factor can be
adjusted for the respective designs. If you modify the factor, the equivalent member length is
adjusted automatically, and vice versa.

You can also define the effective length of a member in a separate dialog box. To open it, click the
button below the upper table.

Figure 2.15: Dialog box Select Effective Length Factor

For each direction, you can select one of the four Euler buckling modes or apply a User-defined
effective length factor kcr. If an eigenvalue analysis has been performed in the RF-STABILITY or
RSBUCK add-on module, you can import the Bucklingmode in order to determine the factor.

Buckling Possible
The stability analysis for flexural and lateral-torsional buckling requires compressive forces to be
included. Members for which this is not possible due to their member types (tension members,
elastic foundations, rigid couplings) are disabled by default. The corresponding rows are dimmed,
and a note appears in the Comment column.

The Buckling possible check boxes in table row A and in the Settings tree allow you to control the
stability analyses: They determine whether the analyses for a member are to be performed or not.

Buckling About Axis y / Buckling about Axis z
The Possible columns control whether there is a buckling risk about the y-axis and/or z-axis. Those
axes represent the local member axes, where the y-axis is the “major” and the z-axis is the “minor”
member axis. You can freely define the effective length factors Ky and Kz for buckling about the
major or the minor axis.

You can check the position of themember axes in the cross-section graphic in the 1.3Cross-Sections
Window (see Figure 2.8, page 9). To access the RFEM or RSTABwork window, click the [ViewMode]
button. There you can display the local member axes by using the shortcut menu of the member
or the Display navigator (see Figure 2.16).
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Figure 2.16: Displaying member axes in Display navigator of RFEM

If buckling is possible about one or both member axes, you can enter either the effective length
factors (columns C and F) or the effective lengths (columns D and G). The same is possible in the
Settings tree.

When specifying the effective length factor K, the program determines the effective length KL by
multiplying the member length L by the effective length factor. The K and KL boxes are interactive.

To define the effective lengths graphically in the work window of RFEM or RSTAB, click . This
button becomes available when you place the cursor in a KL box (see Figure 2.14).

Torsional Buckling
Column H controls whether a torsional buckling design is to be performed. The effective length
factors, Kx, and the torsional buckling lengths, KxLx, can be defined in columns I and J. The x-axis
represents the center line of a member.

Figure 2.17: Member axes

L.T.B.
Column K controls whether a lateral-torsional buckling analysis is to be carried out. The lateral-tor-
sional buckling lengths Lb can be defined in column L.

Modification Factor

In column M, the modification factor Cb for bending according to [1] Clauses 5.4.2.3 or 5.4.2.4 can
be defined for each member.

Comment
In the last column, you can enter your own comments for each member, for example to describe
the selected buckling lengths.
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Set Input for Members No.
Below the Settings table, you find the Set input for members No. check box. If you select this
check box, the subsequent settings will be applied to the selected members or Allmembers (you
can enter the member numbers manually or select them graphically with the button). This
option is useful when you want to assign identical boundary conditions to several members (see
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000726).

With this function, you cannot change the settings you have already made.

2.7 Effective Lengths - Sets of Members

This window controls the effective lengths for sets of members. It is only displayed when you have
selected one or more sets of members for design in the 1.1 General DataWindow (see Figure 2.2,
page 5).

Figure 2.18: Window 1.7 Effective Lengths - Sets of Members

The concept of the window is similar to the previous 1.6 Effective Lengths - MembersWindow. Here
you can define the effective lengths for buckling, torsional buckling and lateral-torsional buckling
for sets of members, as described in Chapter 2.6.
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2.8 Serviceability Data

The last input window controls the settings for the serviceability limit state design of specific
objects. It is available when you have selected one or more load cases or combinations in the
Serviceability Limit State tab of Window 1.1 (see Chapter 2.1.2, page 6).

Figure 2.19: Window 1.8 Serviceability Data

In Column A, you define whether the deformation refers to single members, lists of members, or
sets of members.

For a list or set of members, the orientation and rotation of all contained members must be
identical. This will guarantee that the components of the deformation are taken into account
correctly.

In column B, you can specify the numbers of the members or sets of members that are to be
analyzed. The button enables you to select the objects graphically in the work window. In
column D, the Reference Length of each object is shown. The geometrical lengths of the members,
lists or sets of members are set by default. If necessary, you can adjust those values after having
selected theManually check box in column C.

Column E controls the governing Direction for the deformation analysis. You can select the direc-
tions of the local member axes y and z (or u and v for unsymmetrical cross-sections).

You can consider a Precamberwc in column F, if applicable. The reference to the axes is controlled
by the specification in the Details dialog box (see Figure 3.1, page 19).

The Beam Type is important for the correct reference to the limit deformations. In column G, you
can specify whether a beam or a cantilever is to be analyzed. For the latter, you can define which
end has no support.

The Details dialog box controls whether the deformations are related to the undeformed system
or the shifted ends of the members or sets of members (see Figure 3.1, page 19).
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3 Calculation

3.1 Detail Settings

Before you start the calculation, it is recommended to check the design details. You can access
the corresponding dialog box in all windows of the add-on module by clicking [Details].

Figure 3.1: Dialog box Details

Coefficients of Resistance
The factors of the material resistance are preset according to [1] Table 3 regarding yielding, buck-
ling, instability (𝛾a1) and rupture (𝛾a2). If required, those coefficients can be adjusted.

Check of Maximum Effective Slenderness Ratio
According to [1] Clause 5.2.8, the slenderness ratio KL / r preferably should not exceed 300 for
tension members. For members with compression or flexure, the slenderness ratio should not
exceed 200 (cf. [1] Clause 5.3.4). If required, the limit ratios can be adjusted.

By default, the slenderness ratios are not checked for specific member types, such as “Tension”
and “Cable” members. It is possible, however, to activate the check for all member types.

The limit ratios are compared to the real member slendernesses in Window 3.3. That window is
available after the calculation (see Chapter 4.8, page 28) when the corresponding option has been
checked in the Display Result Windows section of the Details dialog box.
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Serviceability (Deflections)
For the SLS design, the limiting deflections can be separately defined for beams (default: L/360)
and cantilevers (default: L/180). Annex C of the Standard [1] gives recommendations on the
maximum values for deflections.

The options below specify whether the deformations are related to the shifted member ends or
set of members ends (line between start and end nodes of deformedmodel) or to the undeformed
original system. The difference is illustrated by an example in the Knowledge Base at our Web site:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001081

Limit Values for Special Cases
For a simplified design, it is possible to neglect small bending moments, axial or shear forces as
well as shear stresses due to torsion. The limit ratios of the moments, forces or stresses can be
entered in this section of the dialog box.

Those limit settings are not part of the Standard [1]. Changing the limits is in the responsibility of
the user.

Cross-Section Optimization
By default, the optimization is targeted on the maximum design ratio of 100 %. If required, you
can change the limit value in this text box.

Direction of Precamber
When you specify two directions in column E of the 1.8 Serviceability DataWindow and apply a
precamber in column F, you can determine for which direction the precamber is to be considered.

Display Result Windows
In this dialog section, you can select which result windows including parts list are to be displayed
in the output. Those windows are described in Chapter 4.

Window 3.3 Member Slendernesses is deactivated by default.

3.2 Starting Calculation

In all input windows of RF-/STEEL NBR, you can start the design via the [Calculation] button.

The add-on module searches for the results of the load cases, load and result combinations that
are to be designed. If they are not available yet, RF-/STEEL NBR starts the calculation in RFEM or
RSTAB to determine the relevant internal forces.

You can follow the process of the design in a separate dialog box.
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4 Results
Window 2.1 Design by Load Case appears immediately after the calculation.

Figure 4.1: Result window with design results and details

The designs results are shown in Windows 2.1 to 2.5, sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces, Window 3.3 gives information on the
member slendernesses. The last two Windows 4.1 and 4.2 show the parts lists by member and set
of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the
previous or next input window, use the buttons shown on the left. You can also use the function
keys to select the next [F2] or previous [F3] window.

[OK] saves the results. RF-/STEEL NBR is closed and you return to the main program.

Chapter 4 describes the different result windows one by one. The evaluation and checking of the
results is described in Chapter 5 starting on page 31.
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4.1 Design by Load Case

The upper part provides a summary of the results, sorted by load case, load and result combina-
tions of the governing designs. Furthermore, the list is split into Ultimate Limit State Design and
Serviceability Limit State Design results.

The Details section below includes specific information on the cross-section properties, internal
forces, and design parameters for the load case or combination selected in the upper table.

Figure 4.2: Window 2.1 Design by Load Case

Description
This column shows the descriptions of each designed load case, load or result combination.

Member No.
In this column, the number of each member is given that has the maximum design ratio of the
respective loading.

Location x
The column shows the x-location of each member where the maximum design ratio occurs. For
the tabular output, the program uses the following member locations x:

• Start and end nodes

• Division points according to optionally defined member divisions (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member divisions according to specification for member results (see RFEM/RSTAB dialog box
Calculation Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces
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Design Ratio
Columns D and E show the design conditions according to [1].

The lengths of colored bars represent the respective design ratios.

Design According to Formula
This column lists the references of the Standard [1] according towhich the different types of design
have been performed.

DS
The last column provides information on the respective design situations.

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

This window lists the maximum ratios of all members and loadings selected for design, sorted by
cross-section. For each section, the results are given for cross-section design, stability analysis,
and serviceability limit state design.

If there is a tapered member, the cross-sections of the member start and end are listed separately.
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4.3 Design by Set of Members

Figure 4.4: Window 2.3 Design by Set of Members

This result window is displayed when you have selected at least one set of members for the design.
It lists the maximum design ratios sorted by set of members.

TheMember No. column shows the number of themember within the set which has themaximum
ratio with respect to the specific design criterion.

The output by set of members clearly presents the design for an entire structural group, e.g. a
frame.
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4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

This result window lists the maximum ratios of the individual designs for each member. The
columns are described Chapter 4.1 on page 22.

4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location
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This result window lists the maxima for each member at all locations x resulting from the division
points in RFEM or RSTAB:

• Start and end nodes

• Division points according to optionally defined member division (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member divisions according to specification for member results (see RFEM/RSTAB dialog box
Calculation Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces

4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For all designed members, the internal forces are listed that effectuate the maximum ratios of
each type of design.

Location x
This column shows the x-locations where the maximum design ratios occur.

Loading
This column displays the numbers of the load case, load or result combination whose internal
forces result in the maximum design ratios.

Forces / Moments
For each member, these columns present the axial and shear forces as well as the torsional and
bendingmoments which give themaximum ratios in the respective cross-section designs, stability
analyses, and serviceability limit state designs.
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Design According to Formula
The final column informs you about the design types and equations by which the designs have
been performed according to the Standard [1].

4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

For each set of members, this window shows the internal forces that result in themaximumdesign
ratios. The respective equations according to [1] are referred to in the last column.
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4.8 Members Slendernesses

Window 3.3 is shown when you have selected the respective check box in the Details dialog box
(see Figure 3.1, page 19).

Figure 4.9: Window 3.3 Member Slendernesses

The table lists the effective slenderness ratios of the designed members for both directions of the
principal axes. They are determined in compliance with the load type.

Below the list, you find a comparison of the most unfavorable values with the limit values that
have been defined in the Details dialog box (see Figure 3.1, page 19).

Members of the types ‘tension' or ‘cable' are not included in this table.

This window is only informative. It does not provide any stability analysis of slendernesses.
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4.9 Parts List byMember

Finally, RF-/STEEL NBR provides a summary of all cross-sections contained in the design case.

Figure 4.10: Window 4.1 Parts List byMember

By default, this list contains only the designed members. If you need a parts list for all members of
the model, select the corresponding option in the Details dialog box (see Figure 3.1, page 19).

Part No.
The program automatically assigns item numbers to members with identical features.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
Column B shows howmany similar members are used for each part.

Length
This column shows the respective length of an individual member.

Total Length
In this column, the product determined from the two previous columns is given.

Surface Area
For each item, the program gives the surface area relative to the total length. This area is deter-
mined from the Surface Area of the cross-sections. It can be checked in Windows 1.3 and 2.1 to 2.5
in the cross-section properties (see Figure 2.10, page 11).
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Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The unit mass of a cross-section is related to the length of one meter. For tapered sections, the
program averages both cross-section masses.

Weight
The values of this column represent the products of the entries in columns C and G.

Total Weight
The final column gives the total mass of each sectional part.

Sum
At the end of the list, you find a summary of the values in the columns B, D, E, F, and I. The last row
of the Total Weight column shows the total amount of required steel.

4.10 Parts List by Set of Members

Figure 4.11: Window 4.2 Parts List by Set of Members

The last result window is displayed when you have selected at least one set of members for design.
It represents the parts list of structural groups (for example horizontal beams).

Details on the various columns can be found in Chapter 4.9. If a set ofmembers consists of different
cross-sections, the program averages the surface area, volume, and cross-section weight.
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5 Results Evaluation
You can evaluate the design results in different ways. For this, the buttons below the tables are
very useful.

Figure 5.1: Buttons for results evaluation

The buttons have the following functions:

Button Description Function

Ultimate Limit
State Design

Shows or hides the results of the ULS design

Serviceability Limit
State Design

Shows or hides the results of the SLS design

Result Combination
Creates a new result combination from the governing load
cases and load combinations

Color Bars Shows or hides the colored relation scales in the tables

Filter Parameters
Describes the filter criterion for the output in the tables:
Design ratios greater than 1, maximum value or user-defined
limit

Apply Filter
Displays only rows where the filter parameters are valid
(ratio > 1, maximum, user-defined limit)

Result Diagrams
Opens the Result Diagram onMemberWindow
→ Chapter 5.2, page 35

Excel Export
Exports the table to MS Excel
→ Chapter 7.4.3, page 44

Member Selection Option to select a member graphically for tabular results

View Mode Jumps to the RFEM/RSTAB work window to change the view

Table 5.1: Buttons in Windows 2.1 to 2.5
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5.1 Results in RFEM/RSTABModel

You can also evaluate the design results in the work window of RFEM or RSTAB.

Background graphic and viewmode
The work window of RFEM or RSTAB in the background is useful for you to find the location of a
particular member in the model: There, the member selected in the RF-/STEEL NBR result window
is highlighted. Furthermore, an arrow indicates the relevant location x on this member.

Figure 5.2: Indication of member and relevant Location x in RFEMmodel

If you cannot improve the display by moving the RF-/STEEL NBR module window, click the
button to activate the viewmode. Thus, you hide the module window so that you can change the
view in the user interface of RFEM or RSTAB. In the viewmode, you can use the functions of the
Viewmenu, e.g. zoom, move, or rotate the view. The arrow will remain visible when doing so.

Click [Back] to return to the RF-/STEEL NBR module.
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RFEM/RSTABwork window
You can also check the design ratios graphically in the RFEM/RSTABmodel: Click [Graphics] to quit
the design module. In the work window of RFEM or RSTAB, the design ratios are now displayed
like the internal forces of a load case.

In the Results navigator, you can select whether the ratios of the ULS and/or SLS designs are to be
displayed.

Figure 5.3: Results navigator for Ultimate Limit State and Serviceability Limit State designs

To turn the display of the design ratios on or off, use the [Show Results] button which is familiar
from the display of internal forces. To switch the result values on or off, click the [Show Values]
button next to it.

The tables of RFEM or RSTAB are of no relevance for the steel design results.

You can set the relevant RF-/STEEL NBR design case in the list of the toolbar.

The graphical representation of the design results can be controlled in the Display navigator, item
Results → Members. The ratios are shown Two-Colored by default.

Figure 5.4: Display navigator: Results→Members
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When you have selected amulticolor display (optionsWith/Without Diagram or Cross-Sections), the
color panel is available. It provides the common control functions which are described in detail in
the RFEM/RSTAB manual, Chapter 3.4.6.

Figure 5.5: Design ratios with display optionWithout Diagram

The graphics of the design results can be transferred to the printout report (see Chapter 6.2,
page 38).

To return to the add-on module, use the [RF-/STEEL NBR] button in the panel.
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5.2 Result Diagram

You can graphically evaluate the design ratios in a result diagram, without using the work window
of RFEM or RSTAB.

Select the member (or set of members) in the RF-/STEEL NBR result window by clicking in the
relevant table row. Then click the button to open the Result Diagram onMember dialog box.
This button is located below the upper table (see Figure 5.1, page 31).

In the work window of RFEM or RSTAB, the result diagram can be accessed from the menu

Results → Result Diagrams for SelectedMembers

or via the toolbar button shown on the left.

A new window opens. It presents the distribution of the maximum design values on the member
or set of members.

Figure 5.6: Dialog box Result Diagram onMember

You can switch the ULS and SLS results on or off in the Results navigator.

Use the list in the toolbar to select the relevant RF-/STEEL NBR design case.

The Result Diagram onMember dialog box is described in the RFEM or RSTAB manual, Chapter 9.5.



5 Results Evaluation

©DLUBAL SOFTWARE 2017

36

5

5.3 Filter for Results

The RF-/STEEL NBR result windows allow you to sort the results by various criteria. In addition, you
can use the filter options for the tables (see Figure 5.1, page 31) to reduce the numerical output
according to specific ratios. This function is described in the Knowledge Base at our Web site:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000733

Furthermore, you can apply the filter options described in Chapter 9.9 of the RFEM manual or
Chapter 9.7 of the RSTAB manual to evaluate the results graphically.

You can also use the Visibility options for RF-/STEEL NBR to filter the members and evaluate them
(see RFEMmanual, Chapter 9.9.1 or RSTAB manual, Chapter 9.7.1).

Filtering design ratios
The design ratios can be used as filter criteria in the RFEM/RSTAB work window which you access
by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is not, select.

View → Control Panel (Color scale, Factors, Filter)

or use the toolbar button shown on the left.

The panel is described in the RFEM/RSTAB manual, Chapter 3.4.6. The filter settings for the results
can be defined in the first tab (Color scale). As this tab is not available for the two-colored results
display, you have to set the display option ColoredWith/Without Diagram or Cross-Sections in the
Display navigator (see Figure 5.4, page 33).

As seen in the figure to the left, the color spectrum can be set in such a way that only ratios greater
than 0.50 are shown in the color ranges between blue and red.

Filteringmembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results exclusively, i.e. filtered. This function is described in the RFEMmanual, Chapter 9.9.3
or RSTAB manual, Chapter 9.7.3.

Figure 5.7: Filtering design ratios of one frame

Unlike the Visibility function, the entire model is displayed. Figure 5.7 shows the design ratios of
one frame only. All other members are displayed in the model, but they have no design results.
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6 Printout

6.1 Printout Report

Similarly to RFEM or RSTAB, the program generates a printout report for the RF-/STEEL NBR results
which can be supplemented by graphics and descriptions. The selection in the printout report
controls which data of the design module are included in the final printout.

The printout report is described in the RFEM or RSTAB manual. In particular, Chapter 10.1.3.5
Selecting Data of Add-on Modules describes how the input and output data of add-on modules
can be selected.

Figure 6.1: Selecting designs and intermediate results in printout report

Click the [Details] button when you want to include all or specific intermediate results in the
printout report. They can be documented in a Short (compact list) or Long (descriptive list) form.

If you work on complex models featuring many design cases, you can split the data into several
printout reports, thus allowing for a clearly arranged documentation.
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6.2 Graphic Printout

In RFEM or RSTAB, you can add any picture of the work window to the printout report or send it
directly to the printer. In this way, the design ratios shown on the RFEM/RSTABmodel can be used
for the documentation.

The printing of graphics is described in the RFEM or RSTAB manual, Chapter 10.2.

To print the currently displayed graphic of the design ratios, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.2: [Print Graphic] button in RFEM toolbar

The Graphic Printout dialog box appears.

Figure 6.3: Dialog box Graphic Printout, tab General

The dialog box is described in the RFEMor RSTABmanual, Chapter 10.2. This chapter also describes
the other tabs of the dialog box.

You canmove a graphic anywhere within the printout report by using the drag-and-drop function.

If youwant tomodify an image in the printout report, right-click the relevant entry in the navigator
of the printout report. The Properties option in the shortcut menu opens the Graphic Printout
dialog box again. It offers you several options to adjust the image.
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7 General Functions
This chapter describes the menu functions and export options for the design results.

7.1 Design Cases

Design cases allow you to arrange members for specific analyses. In this way, you can combine
groups of structural components or analyze members with particular design specifications, e.g.
modified materials, coefficients, cross-sections.

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-/STEEL NBR design case, you can also use the load case list in the toolbar of RFEM
or RSTAB.

Create design case
To create a new design case, use the RF-/STEEL NBR menu and select

File → New Case.

The following dialog box appears.

Figure 7.1: Dialog box New RF-STEEL NBR Case

Enter a No. (one that is still available) for the new design case and an optional Description. It
facilitates the selection in the load case list.

Then click [OK] to open the 1.1 General DataWindow of RF-/STEEL NBR where you can enter the
data of the new design case.

Rename design case
To change the description of a design case, use the RF-/STEEL NBR menu and select

File → Rename Case.

The following dialog box appears.

Figure 7.2: Dialog box Rename RF-STEEL NBR Case

You can specify a different Description as well as a different No. for the design case.
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Copy design case
To copy the input data of the current design case, use the RF-/STEEL NBR menu and select

File → Copy Case.

The following dialog box appears.

Figure 7.3: Dialog box Copy RF-STEEL NBR Case

Define the No. and, if necessary, a Description of the new case.

Delete design case
To delete a design case, use the RF-/STEEL NBR menu and select

File → Delete Case.

The following dialog box appears.

Figure 7.4: Dialog box Delete Case

Select the design case in the list of Available Cases. To delete this case, click [OK].
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7.2 Cross-Section Optimization
The design module offers you the option to optimize overstressed or little utilized cross-sections.
Open the drop-down list in column D resp. E in Window 1.3 Cross-Sections (see Figure 2.8, page 9)
and select the optimization option From current row.

You can also start the optimization in the result windows via the shortcut menu.

Figure 7.5: Shortcut menu to Optimize Cross-Section

During the optimization, the module determines the section that fulfills the analysis requirements
in the “optimal” way, i.e. comes as close as possible to the maximum allowable design ratio
specified in theDetails dialog box (see Figure 3.1, page 19). The required cross-sectional properties
are calculated with the internal forces of RFEM or RSTAB. If a different cross-section proves to be
more favorable, it will be used for the design. In this case, the graphic in Window 1.3 shows two
cross-sections – the original section from RFEM or RSTAB and the optimized one (see Figure 7.7).

When you optimize a parametric cross-section, the following dialog box appears:

Figure 7.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section: Optimize

By selecting the check box(es) in the Optimize column, you decide which parameter(s) you want
to modify. They activate theMinimum andMaximum columns where you can specify the upper
and lower limits of each parameter. The Increment column controls the interval in which the value
of the parameter varies during the optimization.
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If you want to Keep current side proportions, select the corresponding check box. In addition, you
have to select at least two parameters for the optimization.

Cross-sections composed of combined rolled cross-sections cannot be optimized.

Please note that the optimization does not recalculate the internal forces with the modified
cross-sections: It is up to you to decide which sections should be transferred to RFEM or RSTAB for
a new analysis. As a result of optimized cross-sections, the internal forces may vary considerably
because of the changed stiffnesses of the model. Therefore, it is recommended to recalculate the
internal forces resulting from the modified cross-sections after the first optimization, and then to
optimize the sections once again.

To export the modified cross-section(s) to RFEM or RSTAB, go to Window 1.3 Cross-Sections and
select

Edit → Export All Cross-Sections to RFEM.

You can also use the shortcut menu in Window 1.3 to export one or all optimized cross-sections
to RFEM or RSTAB.

Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections

Before the modified cross-sections are transferred to RFEM or RSTAB, a confirmation is required as
to whether the RFEM/RSTAB results should be deleted.

Figure 7.8: Confirmation when exporting cross-sections

By approving the confirmation and starting the [Calculation] in the RF-/STEEL NBR module, the
internal forces of RFEM or RSTAB as well as the design ratios will be determined in one single
calculation run.

If the modified cross-sections have not been exported to RFEM or RSTAB yet, you can reimport the
original sections in the design module by using the last two menu options shown in Figure 7.7.
Please note that this shortcut menu is only available in Window 1.3 Cross-sections.

When optimizing a taperedmember, the programmodifies the cross-sections of themember start
and member end. For the intermediate locations, the second moments of area are linearly inter-
polated. Since those values are considered with the fourth power, the designs may be inaccurate
if the depths of the start and end cross-sections differ considerably. It is then recommended to
divide the taper into several members, thus modeling the taper layout manually.
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7.3 Units and Decimal Places

The units and decimal places of RFEM or RSTAB and of all add-on modules are managed in one
dialog box. To define the units for RF-/STEEL NBR, select

Settings → Units and Decimal Places.

The dialog box which is familiar from RFEM or RSTAB appears. RF-/STEEL NBR is preset in the
Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

You can save the settings as a user-defined profile to reuse them in other models. Those functions
are described in the RFEM or RSTAB manual, Chapter 11.1.3.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM/RSTAB

If you have modified the materials in RF-/STEEL NBR for the design, you can export those materials
to RFEM or RSTAB in a similar way as you export cross-sections: Open the 1.2 MaterialsWindow
and then select

Edit → Export All Materials to RFEM/RSTAB.

You can also export the modified materials to RFEM or RSTAB by using the shortcut menu in
Window 1.2.

Figure 7.10: Shortcut menu of Window 1.2 Materials

Before the modified materials are transferred to RFEM or RSTAB, a confirmation is required as to
whether the results of the main program should be deleted. When you approve this confirmation
and then start the [Calculation] in RF-/STEEL NBR, the new internal forces and design ratios will be
determined in one single calculation run.

If the modified materials have not been exported to RFEM or RSTAB yet, you can transfer the
original materials to the designmodule via the last twomenu options shown in Figure 7.10. Please
note that this shortcut menu is only available in Window 1.2 Materials.

7.4.2 Exporting Effective Lengths to RFEM/RSTAB

If you have adjusted the effective lengths in RF-/STEEL NBR for the design, you can export the
modified values to RFEM or RSTAB in a similar way as you export cross-sections: Go to Window
1.5 Effective Lengths - Members and then select

Edit → Export All Effective Lengths to RFEM/RSTAB.

You can also use the corresponding option on the shortcut menu of Window 1.5.

Figure 7.11: Shortcut menu of Window 1.5 Effective Lengths - Members

Before the modified effective lengths are transferred to RFEM or RSTAB, a confirmation has to be
approved as to whether the results of the main program should be deleted.

7.4.3 Exporting Results

The RF-/STEEL NBR results can also be used by other programs.

Clipboard
To copy cells selected in the result windows to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example, in a word processing program. The headers of the table columns
will not be transferred.
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Printout Report
You can print the data of RF-/STEEL NBR to the printout report (see Chapter 6.1, page 37). To
export the tables and graphics, then select the printout report menu

File → Export to RTF.

The function is described in the RFEM or RSTAB manual, Chapter 10.1.11.

Excel
RF-/STEEL NBR provides a function for the direct data export to MS Excel or the CSV file format. To
open the corresponding dialog box, select

File → Export Tables.

Figure 7.12: Dialog box Export of Tables

When you have selected the relevant options, you can start the export by clicking [OK]. Excel will
be started automatically, i.e. you do not have to open the program before.

Figure 7.13: Results in Excel
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